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Image Refinements

You can think of this lesson as an extension of last week’s lesson, “Image Blend-
ing,” where we merged five different versions of the same image to get the ideal 
result. To easily find that lesson, navigate to the lesson list on MastersAcademy.
com and use the sort feature to sort the lessons by date. 

In this lesson, we’re going to look at the refinements I would make to an image 
after completing any merging and initial adjustments. With the example image, 
a lot of initial work was done to it. We have a document that has five image lay-
ers. Each layer is based on the exact same raw file. They were each processed 
to enhance a different area and then layer masks were used to merge all of the 
layers together, revealing only the parts that each layer was optimized for. All of 
these layers were placed inside of a folder, or layer Group. A retouching layer was 
placed above the folder in the layers panel, and this layer was used to remove any 
distracting elements from the image. 

As you can see from the Layers panel, this image was processed five times and all five ver-
sions were merged together to create the final document. A retouching layer was placed on 
top of the merged layers. Now, we’re going to refine the image with adjustment layers. 
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Now, I am going to further refine this image by using adjustment layers, and all 
of these adjustment layers will be placed inside of a layer group/folder at the top 
of the Layers panel. Each of these adjustment layers will contain a layer mask, 
which will be used to hide the adjustment in all areas except for the area that ad-
justment was designed to optimize. Note that this lesson is not about selections 
and masking, so I’m not going to cover the process of creating the individual layer 
masks here. I’m just going to focus on the purpose of each adjustment and how 
they are each used to refine the image. 

To add an adjustment layer, click on the Adjustment Layer icon at the bottom of 
the Layers panel. It looks like a circle that is half black and half white. A pop-up 
menu will appear and this is where you will choose the type of adjustment layer 
you’d like to add. When you add an adjustment layer, the Properties panel will au-
tomatically open, containing all of the settings relating to that adjustment layer. 

Hue/Saturation: Desaturate blue stakes 

There are some blue objects in the ground be-
hind the subject’s legs, and I found these to be 
distracting. The first adjustment layer will be 
used to make these objects less noticeable. I’ll 
create a Hue/Saturation adjustment layer and, 
within the Properties panel, I’ll set the color 
menu to Cyans. Then, I’ll move the Saturation 
slider far to the left. This makes the distracting 
objects much less colorful. The problem is that 
the sky also contains a lot of cyan and so it be-
came less colorful as well. I don’t want that, so I 
will use the adjustment layer’s mask to limit the 
area where the adjustment is visible. I’ll fill the 
entire mask with black, hiding the adjustment 
completely. Then, I’ll use the Brush Tool to paint 
with white in the area where the stakes are. 

A Hue/Saturation adjustment layer 
is being used to desaturate the blue 
objects. In the Properties panel, we 
targeted the Cyans and moved the 
Saturation slider to the left. 
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When a masked layer is active, there 
is a way to preview what part of the 
image is being masked. Simply tap 
the backslash key ( / ) and a red over-
lay will appear over the image. The ar-
eas that are red are the areas that are 
being masked, or hidden. The areas 
without the overlay are the parts of 
the layer that are not being masked, 
which means the layer (or adjustment 
layer) is still visible in these areas. 

Curves: Increase contrast in the mountains

You will see that I am going to use the same concept in an adjustment over and 
over again. This adjustment will be designed to selectively increase the contrast 
of different areas of the picture. Whenever you increase the contrast of some-
thing, it makes the details pop out and look a little more interesting. 

The first part of the image that looks a bit dull, or flat, to my eye is the mountain 
area in the background. I’m going to create a Curves adjustment layer to increase 
the contrast in the mountain area.

Before creating the curves adjustment layer, I want to isolate the mountains with 
a selection. This selection will automatically be applied to the layer mask attached 
to the adjustment layer and it will make it so the adjustment is only visible in the 
area that was selected. 

Again, this lesson is not geared toward creating selections or masks, so I encour-
age you to visit last week’s lesson, “Image Blending,” for more details on that. In 
brief, I would use the Quick Selection Tool to make a rough selection of the tar-
geted area. If the area is fuzzy or has complex edges, I would further refine the 
selection by using the Select & Mask command, which can be found under the 
Select menu. 

After painting on the layer mask, the backslash 
key ( \ ) was tapped to get this view of the se-
lection. The red areas are not selected. 



Image Refinements © Ben Willmore, All rights reserved 5

With the selection active, I’ll click on the Adjustment Layer icon at the bottom 
of the Layers panel and choose “Curves” from the pop-up menu. The curves ad-
justment layer will appear in the Layers panel and the selection will automatically 
be applied to the layer mask attached to the adjustment layer. The area that was 
selected (the mountains) will be white, which means that the adjustment will be 
visible in this area.

The curve chart will appear within the Properties panel. I’m going to make sure 
that the little hand tool (or targeted adjustment tool) in the upper left side of the 
panel is turned on. I actually like to set things up so this tool is turned on all the 
time, and you can do that by clicking the little hamburger menu in the upper right 
corner of the panel and choosing “Auto-Select Targeted Adjustment Tool” from 
the pop-up menu. 

Now I’m going to move my cursor into the area I want to adjust (the mountains) 
and click to place two points on the curve. One of the points should target the 
brightest area within the mountains and the other point should target the darkest 
area within the mountains. 

After creating a 
Curves adjust-
ment layer, I’m 
clicking within the 
image to place 
two points on the 
curve: one point 
for the dark-
est area in the 
mountains and 
one point for the 
brightest area in 
the mountains.
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There are now two points on the curve chart. One point (the one higher in the 
chart) represents the bright area and the other point represents the dark area. 
You can look at the gradient beneath each of the dots to see exactly how bright 
the targeted areas are. I want to make the mountain area pop by adding contrast, 
and I can do that by making the curve steeper between these two points. You 
can make a curve steeper between two points by moving the lower dot down, 
by moving the upper dot up or by doing both of these things. By moving both 
points, I would get a more dramatic change. In this case, I think I will just make 
the bright areas brighter. I will click on the upper dot (the bright one) to make it 
active and then I’ll use the arrow keys to move the dot up a bit. The mountain area 
will change as I do this. 

Another way of moving points on a curve is to click within the image to create 
the point and then, without releasing the mouse button, dragging up or down to 
move the point up or down on the curve. 

The upper dot, 
which represents 
the brighter areas 
in the mountains, 
is being moved up 
to create a steep-
er curve and this 
will therefore add 
more contrast. 
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To see a before and after view of the adjustment, I’ll toggle the eyeball icon at the 
bottom of the Properties panel. 

Whenever you increase the contrast, you will find that the picture may become more 
colorful. You can prevent this from happening by changing the blending mode of 
the adjustment layer to Luminosity. The Blending Mode menu can be found at the 
top of the Layers panel. When the blending mode of a layer is set to Luminosity, it 
will only be able to change the brightness of the image (not the color). 

Curves: Increase contrast in the vines 

Looking at the greenery in the image, certain areas of the vines look a bit dull. I’m 
going to use another Curves adjustment layer to give them more contrast. First, 
I’ll make a selection around the areas I want to affect. It can be useful to use the 
Brush Tool to paint in a selection and I can do this by entering Quick Mask Mode. 
I’ll make sure that the brush size is how I want it, I’ll make sure the foreground color 
is set to black and then I’ll tap the Q key to enter Quick Mask Mode. I won’t see any 
visual indication that I’m in Quick Mask Mode because there is currently no active 
selection. I will start to paint (with black) on the vines and a red overlay will appear 
in the areas where I paint. I will paint over all the areas within the vines that could 
benefit from having more contrast. The problem is that the red overlay represents 
the area that is NOT selected, so I will need to invert the selection so that I get 
the opposite. To get the opposite of a selection while in Quick Mask Mode, I’ll click 
on the Image menu and then choose Adjustments > Invert. Alternatively, I could 
use the keyboard shortcut Command+I (Ctrl+I on Win.) Now, everything has a red 
overlay EXCEPT for the area I want to target with the adjustment. 

Quick Mask Mode is 
being used to create 
a selection. The Brush 
Tool was used to paint 
on the vines and then 
the mask was inversed 
so the vines are the 
only part selected.
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I’ll tap the Q key again to exit Quick Mask Mode and I’ll see the “marching ants” 
selection. With the selection active, I’ll click on the Adjustment Layer icon at the 
bottom of the Layers panel and choose Curves from the pop-up menu. When I 
do this, the active selection will automatically be applied to the layer mask, where 
the selected area is the only part of the mask that is white. The Curves Properties 
panel will appear and I’ll make sure the Targeted Adjustment Tool (the little hand 
icon) is turned on. I want to use this adjustment to increase the contrast in the 
part of the vines that I selected so I will first click on the darkest part of that area 
to place a point on the curve. Then I’ll look for the lightest area within the part 
of the vines that is targeted. I’ll click and drag up on that part, which will place a 
point on the curve and move that point upward, making that light tone even light-
er. This will increase the contrast, making the area pop out a little more. 

Curves: Increase contrast in the bottom of the vines

I’m going to make yet another Curves 
adjustment layer to increase the con-
trast in the lower part of the vines be-
cause I feel that this area is a bit dull as 
well. I didn’t include this area in the last 
adjustment because I wanted to be able 
to use different Curves settings to add 
a different level of contrast. When you 
adjust the various areas independently 
like this, you’re able to have complete 
control over each area. 

To add contrast to the bottom part of the vines, I’ll follow the same process as 
above. I’ll make a selection of the vines and then create a Curves Adjustment 
Layer, converting that selection into a layer mask. Two dots were added to the 
curve: one for the dark parts and one for the bright parts. The dot for the bright 
areas was moved up, making those areas even brighter and adding contrast to 
the targeted area. 

A Curves adjustment layer was used to add a 
little contrast to the bottom half of the vines. 
Here is the before and after views of that area.
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Curves: Increase contrast in the trunks

Once again, the same technique will be used to increase the contrast in the “trunk” 
part of the vines. After the trunks are selected, I’ll create a Curves adjustment lay-
er, add the two points and then move the point representing the bright areas up, 
making the brights even brighter. 

Hue/Saturation: Decrease color in the trunks

After increasing contrast in the trunks of the vines, I notice that they became a lit-
tle more colorful than I’d like. I can use a Hue/Saturation adjustment layer to cor-
rect this. I’ll click on the Adjustment Layer icon at the bottom of the Layers panel 
and choose Hue/Saturation from the pop-up menu. In the Hue/Saturation Prop-
erties panel, I’ll drag the Saturation slider to the left to make things less colorful. 
Because the layer mask attached to the adjustment layer is completely white, this 
adjustment is happening to the entire picture, and that’s not what I want. I only 
want the adjustment to affect the trunks of the vines. I don’t need to create a new 
selection of this area because I already created the selection when I added the 

The trunk parts of 
the vines were iso-
lated with a selec-
tion and a curves 
adjustment layer 
is being used to 
increase the con-
trast. Two points 
were placed on the 
curve and the point 
representing the 
bright areas is being 
moved up, making 
those areas even 
brighter. 
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previous adjustment layer. There is a way to make this adjustment show up in the 
areas where the underlying layer is visible, and that is by creating a clipping mask. 
I’ll click on the left-most icon at the bottom of the Properties panel and this will 
link the layer to the one beneath it, creating a clipping mask. In the Layers panel, 
you can see that the adjustment layer icon becomes slightly indented and there 
is a downward-pointing arrow to the left, indicating that it is clipped to the layer 
beneath it. What’s nice is that if I update the layer mask on that underlying layer, 
it will automatically be applied to this Hue/Saturation layer as well. 

There are two other methods for clipping a layer to the layer beneath it. All of 
these methods do the same thing. With the layer you want to clip active, click on 
the Layer menu and choose “Create Clipping Mask.” Alternatively, you can hold 
down the Option key (Alt on Win) and click on the line between the two layers in 
the Layers panel. 

The Hue/Saturation adjustment layer is being clipped to the Curves layer beneath it. When a 
layer is clipped, it will only be visible in the area where the underlying layer is visible.



Image Refinements © Ben Willmore, All rights reserved 11

Curves: Increase contrast in the skin tones

Moving on to a different area of the image, I will focus on adjusting the subject’s 
skin. Again, I want to increase the contrast by making the bright parts brighter, so 
I will make a selection of the skin, create a Curves adjustment layer and place two 
dots on the curve. I’ll move the dot representing the bright areas upward, making 
those areas even brighter. 

Hue/Saturation: Tone down the color in the skin

The increase in contrast made the skin area a little too colorful, so I’ll create a 
Hue/Saturation adjustment layer to correct this. I’ll click on the Adjustment Lay-
er icon at the bottom of the Layers panel and choose Hue/Saturation from the 
pop-up menu. In the Properties panel, I’ll move the Saturation slider to the left, 
making things less colorful. The problem is that the entire image became less col-
orful. Again, I’ll use a clipping mask to limit where this adjustment appears. The 
underlying Curves layer contains the layer mask that only reveals the skin area, 
so I’ll click on the Clipping Mask icon at the bottom of the Properties panel to clip 
the Hue/Saturation adjustment layer to this underlying Curves adjustment layer. 
Now, the desaturation effect will only be visible in the areas where the underlying 
Curves layer is visible. 

Curves: Lighten top of mountain

The very top of the mountain looks like it’s a bit darker than the rest of the moun-
tain, almost as if there is a shadow cast on it. I would like it to be the same bright-
ness as the rest of the mountain and I’ll use a Curves adjustment layer to achieve 
this. Note that this step was detailed in last week’s lesson “Image Merging.” In 
brief, I made a selection of the area I wanted brighten and then created a Curves 
adjustment layer. The selection was automatically applied to the layer mask. I 
then clicked within that darker area to place a dot on the curve. This dot was 
moved up until the brightness of the target area matched the brightness of the 
rest of the mountains. 
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Curves: Add contrast to shirt

I want to increase the contrast in the shirt so I’ll make a selection of the shirt and 
then create a Curves adjustment layer. The selection will be applied to the layer 
mask, so any changes I make using this curves layer will only be visible in the area 
where the shirt is. I’ll place two dots on the curve: one for the darkest part of the 
shirt and one for the brightest part of the shirt. I’ll move the dot for the bright ar-
eas up, making those areas even brighter and increasing the contrast in the shirt. 

If you ever add a dot near the top of the 
curve and find that the top of the curve 
flattens out along the top of the chart, 
you can correct for this by adding an-
other dot to the right of the existing dot 
and moving it down until the curve pulls 
away from the top of the chart again. 

Hue/Saturation: Desaturate leaf

There is one leaf sticking out from the vines 
that is a vibrant red. It calls my attention a little 
too much so I’m going to create a Hue/Satura-
tion adjustment layer to make that leaf a little 
less colorful and therefore less distracting. I’ll 
click on the Adjustment Layer icon at the bot-
tom of the Layers panel and choose Hue/Satu-
ration from the pop-up menu. In the Hue/Sat-
uration Properties panel, I will make sure that 
the Targeted Adjustment Tool (the little hand 
icon) is turned on and I will use this tool to click 
on the leaf and drag left. When I do this, Pho-
toshop will automatically target the hue that’s 

Adding a point near 
the top of the curve 
caused the curve line 
to flatten out along 
the top of the chart. 
Another dot was 
added (to the right of 
the existing dot)  to 
smooth out the curve.

A Hue/Saturation adjustment layer is 
being used to make the red leaf less 
colorful. 
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in the area where I click (red) and move the Saturation slider to the left, making 
everything that is red less colorful. 

Now, I have done nothing to the layer mask, so it is completely white, which 
means that the adjustment will be applied to the entire image. I only want this 
adjustment to apply to the leaf, so I want the entire layer mask to be black except 
for the area where the leaf is. To achieve this, I will click on the Image menu at 
the top of the screen and choose Adjustments > Invert. This will invert the mask 
to make it entirely black. Now, I will activate the Brush Tool and make sure I’m 
painting with white as I paint over the leaf. This will reveal the adjustment in just 
that area. 

Curves: Make the vines pop

I’m looking to refine this image further so I’m going to make the vines pop out 
even more than they currently do. I’ll use another Curves adjustment layer, follow-
ing the same exact process to achieve this.

Curves: Remove glow from vines

Part of the area where the vines meet the 
mountains looks like it has a glowing ef-
fect, or halo, around it. I’ll create a Curves 
adjustment layer to correct this. With the 
Targeted Adjustment Tool active, I’ll click 
on the area that I want to fix, which is the 
area that looks a little too bright where the 
vines meet the mountains. Now, I’m not 
going to place a second dot, but I’m go-
ing to hover my cursor over the part of the 
mountains that has the ideal brightness. A 
little circle will appear on the curve (tempo-

The cursor is positioned over the area 
that has the ideal brightness and the cir-
cle on the chart represents that  
brightness level.
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rarily) and I will note the height of this circle on the curve. I would like the point I 
placed to match the height of this circle. What I’m basically saying is that I want 
to make the targeted area (the too-bright area) match the brightness of the ideal 
area. With the dot active, I’ll use the down arrow key to move the dot down so 
that it matches the height of the circle. 

This has a darkening effect on the entire image because the layer mask attached 
to this Curves adjustment layer is completely white, which means that the adjust-
ment is applying everywhere. I’ll invert the mask by clicking on the Image menu 
and choosing Adjustments > Invert. Now the mask is completely black so the 
adjustment is not applying anywhere. 

Now, If I were to start painting with white on the mask to reveal the darkening ef-
fect in the target area, I’m going to get overspill into the vines. In order to prevent 
this, I need to create a selection of the mountains so that selection limits my paint 
strokes, preventing any overspill into the vines. 

Looking down at the adjustment layers 
I’ve already created, there is already a 
mask that isolates the mountain area. 
I can use this mask to create the se-
lection that I need for the new Curves 
adjustment layer. To create a selection 
based on this mask, I’ll hold down the 
Command key (Ctrl on Win) and click 
on the thumbnail for that mask that 
isolates the mountains. A marching 
ants selection will become active and I 
can now paint with white on that area 
where the mountains meet the vines, knowing that the selection will make it so 
there will be no paint overspill into the vines. 

The selection of the mountain area will be used 
to ensure that no paint overspill gets into the 
vines when I paint on the layer mask.
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Curves: Vignette bottom of image

When we add a vignette, we’re darkening the edge of the picture in order to draw 
the eye into the center of the image. In this image, I want to create this darkening 
effect on the bottom of the frame. I’ll create a Curves adjustment layer and, in-
stead of clicking within the image to add a point to the curve, I’ll simply drag the 
far right end of the curve down a bit. This will darken all of the brighter areas in 
the image. I’ll then invert the layer mask (Image > Adjustments > Invert) so that 
it’s completely black and I’ll use a soft brush to paint with white on the bottom of 
the frame, allowing the darkening effect to show through in this area only. 

Place adjustment layers in a group

Now that I’m finished creating all of my adjustment layers, I will select all of these 
layers and then click on the little folder icon at the bottom of the Layers panel. 
This will place all of the selected layers into a layer group, or folder. I’ll rename the 
group to “Adjustments.” 

A Curves adjustment 
layer is being used to 
add a vignette to the 
bottom part of the 
image. The top right 
point of the curve 
is being dragged 
down, darkening all 
of the bright areas. A 
mask is then used to 
limit this adjustment 
to the bottom part 
of the image.
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Bora Bora Image

Here is another image where I’ll follow a similar process of refinement. Before 
creating the adjustment layers, I created two new, empty layers on which to ap-
ply the retouch work. One of these layers was used to remove the tourists in the 
background and the other layer was used to remove any other distracting ele-
ments. The adjustment layers will be placed on top of these retouching layers in 
the Layers panel. 

I have already detailed the process behind making the layers and working with 
the different adjustments, so here, we’ll just quickly list each adjustment that was 
made as well as its purpose. 

1. Curves: Increase contrast in dock  I wanted to make the dock pop out a little 
more, so I created a Curves adjustment layer to increase the contrast, using 
the layer mask to make sure that the adjustment only affected the dock. This 
adjustment made the dock more colorful, which is not something I wanted, 
so I changed the blending mode of this adjustment layer to Luminosity. (The 
blending mode menu can be found at the top of the Layers panel.) When in this 
mode, a layer can only affect the brightness and not the color of the image. 

2. Curves: Increase contrast in the mountains The mountain area looked a bit 
dull, so I created another Curves adjustment layer to increase the contrast in 
the mountains, making them pop out a bit more.  Two dots were placed on 
the curve: One dot for the dark area, which was not moved, and one dot for 

A layer mask was created to 
isolate the adjustment to the 
dock area. 
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the bright area, which was moved up to make the area brighter. The area also 
looked a bit blue because it was in the shadows. Using the same curve adjust-
ment, I changed the color menu to Blue and then moved the curve point down 
a bit, making the area a little less blue and a little more yellow. Whenever you 
decrease the blues in an image, you will be introducing more yellow because 
yellow is the opposite of blue. 

3. Curves: Make the water pop The next Curves adjustment layer was used to 
increase the contrast of the water area. Again, this was achieved by placing 
two dots on the curve and moving the brighter dot up a bit to make the bright 
area brighter. This increased the contrast as a result. 

4. Hue/Saturation: Color correct mountains  I noticed that the color of the moun-
tains on the right side of the frame are much more colorful than the rest of the 
mountains in the scene. I used a Hue/Saturation adjustment layer to correct 
this. I started off by creating a selection of the mountains so that this selection 
would automatically be applied to the adjustment layer’s mask. After creating 
the adjustment layer, I made sure that the Targeted Adjustment Tool was ac-
tive and I clicked within the area I wanted to correct (the colorful mountains). 
This caused Photoshop to set the color menu to yellows, which is the domi-

The mountains in the 
back were isolated us-
ing the layer mask at-
tached to this Curves 
adjustment layer. Two 
points were placed 
on the curve and 
the bright point was 
moved up, increasing 
contrast. The blue 
curve was also moved 
down, making the area 
more yellow and less 
blue.
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nant color in the targeted area. Then, I moved the Saturation slider to the left, 
which made all of the yellows in the image less colorful. I also moved the Hue 
slider to the right slightly. The Hue slider changes the actual color of the tar-
geted area. In this case, moving the slider to the right a bit made the targeted 
color range more blue and less yellow.  

5. Curves: Water highlights I already adjusted the water once, but I wanted to 
adjust it a second time to really make the highlights pop. I followed the same 
Curves technique that I’ve used many times in this lesson, creating two points 
on the curve and then moving the point representing the brights up a bit. 

6. Curves: Karen Pop  Next, I wanted to make the subject pop out of the frame 
a bit more, so I made a selection of the subject and then created a Curves 
adjustment layer so that the selection would automatically be applied to the 
layer mask. I added two dots to the curve (one for the bright area and anoth-
er for the dark area). In this case, I moved both of the points up a bit, which 
brightened both the highlights AND the shadows. 

Here, you can see a before and after 
view of the mountains and the Hue/Sat-
uration adjustment layer that was used 
to make the change.
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7. Curves: Sky pop Finally, the last adjustment layer I added was to make the 
sky look better. I made a selection of the sky and then created a Curves ad-
justment layer so the selection was automatically applied to the adjustment 
layer’s mask. I added one point for the bright area and one point for the dark 
area. In this case, I moved the point representing the dark areas down, darken-
ing those areas that were already dark. 

The final result, after creating all of the adjustment layers.


